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Accounting

e Vendor No. Search Field

Within the A/P Browse screen, the second tab for “Vendor No.” has been updated to allow
users to search unpaid A/P items for a specific vendor as designed.

Searching by Vendor Ref
from A/P management has
B Browse Poste been fixed

| Check Number | Fie Numbee

St [T Show Posted B2 Only ¥

[oor14i] 5y F2-Seea o Bectlc Show Open Biks Oty [

By Your Refecence No. |n,vmnamua| CNS-CASS

You Relererca No | lov. Date | DIV| STATUS Jewe T Balance DusDate| VendorRefNo | Disc. Dye Pad|
001-15112053R 11707 33| POSTED $(25.00); $0.00; 12/29/06/001-15112053 12/22/06 117207 0
001:15112053R 11707, 33| POSTED $(10.35)| $0.00 12/23/05,001:15112053 12722708, 11707 0
001-15112053R 11707 B‘ POSTED ${187.60)' $0.00 12/23/06001-15112053 12722008 117207, 0
001-15112084 12/28/06, 33| POSTED $105.00 $0.00  1/04/07]001-15112064 12728006, 117207 0
001-15112064 12/28/06 33| POSTED $0.00. 1/04/07/001-15112084 12728006, 117,07 0
001-15112064 12/28/08 33| POSTED $7.50. $000  1/04/07/001-15112064 12/28/06, 117207, 0
001-15112084R 117/07, 33| POSTED $0.00| 1/04/07/001-15112064 12/28/06: 117207, 0
001:15112084R 1N707 33| POSTED $(105.00) $000 1/04/07,001-15112064 12/28/06 11707, 0
001-15112064R 11707 33| POSTED $(25.00) $0.00 1/04/07,001:15112064 1 11707, 0
001-15112075 11907 33| POSTED $100.00 $0.00 1/26/07/001-15112075 11907 21407, 0
001-15112075 11907, 39| POSTED $1500 $0.001 1/26/07,001-15112075 118207 211407 0
001-15112075 1/18/07] 33| POSTED $060 $0.00.  1/26/07001-15112075 11807 2114/07 0 _l
001-15112075R 214707, 33| POSTED ${060) $0.00 1/26/07,001-15112075 119207 21407, 0
001-15112075R 2/14/07, 33| POSTED $(100.00)' $000 1/26/07,001-15112075 1719707 211407 0
001-15112075R 2/14/07) 33| POSTED $(15.00) $000 1/26/07,001-15112075 119707 2/14/07, 0
001-15112086 1/23/07| 33| POSTED $276.00 $0.00 1/30/07|001:15112086 1723007, 2715407, 0
001-15112085 1/23/07, CB‘ POSTED $44.40 $0.001 1/30/07/001-15112086 1723707, 211507, 0
001-15112086 214207, 33| POSTED $180.00 $0.00/  2/21/07/001-15112086 214207, 215407 0
001-15112086R 215/07 33| POSTED $(275.00) $0.00. 1/30/07001-15112085 1723007, 271507 0
001-15112086R 2/15/07) 33| POSTED $(44.40) $000] 1/30/07001-15112085 172307 211507 0
0 £0 $0.001 _2/21/07,001-15112085
»~]

TowBoce  0NDye 31900 S WISDa %50,
| IMN0RE 21057 GOS8 s |
. Payments Be L3 (3 & AP &l
a?!::um | "‘aull'-ﬂ! I '?i'?a«:‘;-' | Nﬁt I Eﬁ na.l 7 Mansgemant | Lap I Close |
L

e Default Check Number Resetting

The check number field that automatically updates to the next check number upon creating a
new check will no longer reset to “1” after a wire transfer is previously completed and the user
then goes to input a new check.

e Copy Invoices
The line items on invoices will now properly copy over when using the “Copy Invoice” feature in

Accounting.
»
| |

Open Balance 010Days  11-FDays  31-45Days  465600aw B0+ Days

TEST CLENT | 542500 5250 000 000 19000 5000 ‘
" v 3 Q |rhmdl~ldu

HE D:e..l —“” IENK I N

. y P Beverse .J

dmm | ﬁlmﬁ:' Close
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Originally, the copied invoice was not copying over the charge item:

A Update Invoice # 15528

Ironce Ma, Cusstamer 1D 1 0ele 13 Divvizian Business Line P/C

[ 15628 |TEscu Q | 1 [tz = [0 & 5 & FRD v

TESTCLENT Ssinashtemali  OCEANEXPOF
Tems Due Date Reference Mo,
[ooars (G| ven2 = [15ezs

30 DW'YS FROMBIL DAT

F/C] Chargs Code  [Disizion] Bus. Line] Dsscriplion ALt | “Wando [F/C] “Vendorlroeica # | endor Al

Info Missing from

Copied AIR
LIEL N T T |
F| o 3 (5l Payments Total Biled Cunent Balsnee Tekal Cost
Mo Ecit Delete | Receivad 1] BL £0.00 $£35.00 $0.00
2 L3 B = H FE) [x]
Mates Dacs _I Frk Save and Past Sawe Cancel

Now, this item correctly copies over when using the “Copy Invoice” button on the A/R browse

screen:

A update Invoice & 15628

Iryoce Ma. Cusstomer I 1 [ale Irw Divisian Business Line e

[ 15828 |TEscu Q | 1 [ vz = o & 5 & [pro =]

TESTCLENT Sabnasisnati  OCEANENPOR
Teims Due Date Refererce Mo,
[ooavs & anz [E [156ze

0 DTS FROM BIL OAT

“andor Irvoice

AR FHEIGHT HARDLING

IEL N A A CO YT 2
3 " La (5ol Paymerts Total Biled Cunent Balancs Teasl Cot
Nesw Edit Dielete 4| Rieceived Upeate B/L $35.00 $35.00 $0.00
Q [ B = g FE| a

Motes Docs o Frirk Sawe and Fost Save Cancel

2011
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e Prepayment Reference Numbers

Prepayment file number selection now correctly displays the chosen linked file number as the
A/P reference number automatically as it should. Before this was corrected, the system would
not automatically fill “Your Reference No.” with the selected “Related File Number” reference.

A single Line Item A,/P Entry

Related File Humber Wendor ‘rour Reference Mo, Division Busziness Line

030003 Q | |5rEGOR &y |030003 [ ] [ &

AE Shipment

This field will relate the payable | Expense Code : Currency Exchange Date: Exchange Rate: Expenze Amount Invaice Date

invoice to the Shipment o L
rumber entered. | aQ |USD Q |12f25£2011 =] |1.uuun | $0.00 |12£25I2D11 =]
If the Check Box below is st $0.00

then when the shipment is

invoiced any pavables will be | endor Inv. Date Wendor Reference o Payrment Group Terms Due Date

pdielal el e [t2i28r2011 (] [EST | Q] Q [izesmm
V¥ Automatically Bill this ltem on | Amount to Bil Customer | & prep i =1 Savek (X

= Post

Cancel

the related A{R Invoice. I $0.00  Collect Not:as

All Modules

e Report Manager/Credit Rules

Changes have been made to Report Manager to allow document restrictions based on credit
rules for Domestic Shipments. Other credit bypass issues with Ocean Export files have also
been resolved.

A Record Will Be Added

Description : |

Meszage :

<< FORWARDER 2000+ f NVOCC 2000+ - MIAMI INT'L FREIGHT §

Edit Do Tracing Reports Rates Schedule-B#s EDI Hel
Print Setup... o= -y

) == - — Type of Report Restricion/F
Tables Maintenance * lracing Clients  Contacts & Waming © Acknowle

Document Maintenance r TrueVis 4 [ These

View Formats

System Maintenance > . . _
View Fields Module : Client 10
Denied Party Screening > View Printers - |
b odule
Issue Credit Override Authorization Web Documents Ocean Expart ——
Document [ssuance [&ir - Export ALSEISLE
User Maintenance e Ocean - Impart
Report Managecy \sir - Impart
e g |CHE
i
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AES

e AES “Submitted” Message

The “Submitted” status message has been re-instated on the Status screen showing when an
AES submission has been performed on an Export Shipment. This message indicates a file was
submitted to AES, but has not yet been accepted.

Slalus and Tracklng Info. for Shipment 14761 (
Status/Tracking |Freighlf8hipment Tatals Courier Infarmation
—Status — Additional Customer References
. -
3rd Party Tracking: Booking By : r,_--_‘" %EE:;?
| Q [ J£SON FIELDER
Utimate Custamer : Praject Ma. j
I “ [ Hew [+ Edit [ d Delete
AES Status Date Time 1Tk Originals  Copies (
|suBMTTED | | | @ [5 [o (
File Cpened : Booked : Doc's Recyd. In Banking : BiL Printed : Rail Cut Off I:Date.l’TimeJ

*228:‘2011 DIDDIDDDD L 0. i} 000000 _| 0000000 | DIDDIDDDD f\ DD
SN TP N O PN eI P R IR P TN

e AES Message Screen
The AES Message shortcut accessed through the shipment Status screen has been activated
again to show the results received from AES.

Status and Tracklng Info. for Shipment :14331 :
Status/Tracking |Freight!8hipment Totals Courier Information £
[ Status —Additional C References
| =l | )
3rdd Party Tracking: Booking By : EI' %EE:;ZT
Q | 450N FIELDER
Uttimate Customer Project No ‘
I K I 4 [ Hew [} Edit J Delete )
AES Status Dite Time: Tk Otiginals  Copies
| accepTED |anzons | [1214Fh [xz0111225000000 || AES Reporting Button has B o
- been reinstated .
File Opened : Booked : Doc's Recwd. In Banking : Printed : Rail Cut Off (DatelTime)
e CTTZI S R [ TS Y LT TR ) (T T S [T ) [y

Hitting the button when it is “Red” will now take you to the corresponding AES screen for that
file, and show you the accompanying results from AES that indicate what needs to be

corrected. See highlighted area below.

2011 Page 6
All information contained herein is confidential. IES: The Software Solution for the Future of Freight.



IES

A Update Export Declaration Information... E
Ex/Dec Mode Status Date Time ITN )
MNormal FAILED EDIT ‘
AES Exempt / Reasor: || g ;

USFFI USFF 1D USPPFIID Type  Cargo Origin Origin State B
|ExPORTO! O, |51287435 JEIN > | Q [m & I PatiesRelated [ Routed 3
EXFORTER
Method of Transport LS. Port of Export E xport [ ate E=porting Carrier Fast Departure Filing '
| wessel ~|  Juseos & iz G [Maeu Q| =] *
EOSTOMN MAERSK LIMES, INC.
I Split Shipment by Air I~ | Hazardous Goods

In Bond Code Entry Humber FTZ Mumber Shipper Supplied ITH [e.g. X20081231123456) r
I FO-Merchandise NOT shipped inbond j I I 4

Country OF Destination Port Of Unlading “eszel

DE | CrsHe, | HaNJIN KDBE +.1111

Sch duIeB Mo,

[d Hew [} Edit

;_a Delete

E‘j Copy Commercial | rvoice @ Imnport Cugtomer Data

SE BOLSTERS FOR T

Date Time Message

o Save x Eancel)

Code

127272011

Air Export

03:18PM | USPPIID NUMBER MUST COMTAIN 3 0F 11 CHARACTERS : ADMIN IES

L " W..‘\ o> “J‘. J~ *_“."““ -u—\j

e Bill To Code on Invoice

The system will now allow the “Customer”

Unasmgned Inv. Line ltem

GREGORY EUTLER COURIER SERVICE

Customer ; Charge Code ; Oweride Divizion
[courieR Ql «

on the billing invoice line item to be manually
changed to a different party other than Account on the file.

Ovwveride Business Line

IS

AIR Charge Detall

Cumency Euchange Date Euchange Bate
fuso & [12/2m/2011 | 1.000000
usa
Ppd/Cal  Charge Basis Lurnp Surn Urit Rate Total Charge
[P =] [Lomesum ~1 T > @ | #1500 = | $15.00
Irvioice Description $15.00 $15.00
ICDUHIEH SERVICE 5 B
) s escription to prink ICDUFIIE
¥ ‘. ""MM e -A.M-’\ Pkl ﬁ "

:
¢
£
\
'
A .

Before the correction, this field would revert back to the party indicated in the “Account” field

on the shipment screen.

2011
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e Destinations on Scheduled MAWB
Destinations will now correctly populate on scheduled Master Air Wayhbills.

A Schedule Master AWB / File No. 000500010

Adrline Divizion Buz. Line File Mumber &/ B Uszer Mame Agent/Conzignee
Im Lkl Q IDS Q, IDDDEDDDW a01-11122303 ADMIN I Q
Airport of Depafture and Requested Routing
flan G
Flight/[1ate Ta Flight/Date Ta Flight/D ate

|_Lk|_U~|—

I_u. l_u.l— [« l_uul—

Cutaff Date ¢ Cutaff Time ETA Date / ETA Time

Airport of Destination Courtry Flight D ate
ISTUTTGAHT IDE Q| |1zesmt 2 [oomon [E [sswsw o000 [ e

@| =] o

CHB

e Total Containers on Entry Manifest
The number of maximum allowable containers on the “Total Containers” field has been
expanded from 100 to 999. This field is located on the Entry Manifest tab of the CHB entry

screen.

Entry { TOM )
IES GUID:  709,000,000,733%

Entry Humber  Broker Ref. Entry Type Gross Weight Charges Est. Entiy Date Entry Sum. Date
[#E7-0032234-2  [105501125 | Q| | $0.00 l:u | = | =]
[~ Live I Manual Enty LinkaShipment:' Link. |_|

General Manifest |I_nvoices I 7h01 |§451 I Payment I Selectivity I Status I ﬂotesl
Ih Bond # b azter Bill House Bill Sub-Housze Bill uantit A0S I Total Containers: I 999 3:
YER OO 0016k | EGLYE4010009767 5 0 PCS M A8

Containers/Delivery Orders

Shipment: I ;I

|_3 LA |_a /r Shipment Quely I ariifest I_EJ A La
New Edit | Delste Nurnbers Mew Edit | Delete
P = Query pending M = One or more do not exist E = All exist | =15F onfile M = Mismatch, not related Delivery Orders
Mare. .. ey 1‘3 & & @ dgl =] (]
1SF Billing EDI Statuz Adjustments Doz Submit Print Save LCancel
Data “ersion:11 hiethod: Generate from Invoice Data 7601 Format: Grouped by Invoice Form “arsion &

Page 8
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e Tracking from CHB

Multiple improvements have been made to the entry tracing in the CHB module. FTZ
admissions are now traceable as well as tracing by country of origin will now be complete.
o FDA Prior Notice
If a House B/L or HAWB exists on an entry, it will now populate into the FDA Prior Notice
screens when creating the prior notice.
A FDA Information Y
\utrsiow
General | Prior Notice Prior Notice [cont.] |Allilmatinn Eodesl &
Producer [~ Ovenide Automatic 5 ettings "v
Firrr Type: | =] .
FOs Begistration | :
E semption; | =l S
Shipper [T Owveride Automatic S ettings
FOws Bemistration: I
Transit Carrier. W Carrier Country: I ‘
Master Bil: [EGLWS40100097678 | WNYOCT House: [ TOMET 2261023456 | "Special Bill"
Air W aphill: | House Air W ayhill: | (
“ovageFlight/Trip: I Crogzing Paint; | )
Container Mo | Rail Car No'l y
Additional container numbers and rail car numbers can be e tered an the F\FFumatlon of Compliange tab using code
A Al agpant G anges i Sitens, ~‘--.~ "-L mx*‘u} SV ‘,‘"‘""‘/
e Foreign Phone & Fax
The FDA Prior Notice screens will now support foreign phone and fax numbers.
A FDA Information
General Prior Hotice |Pliur Motice [cont.] | Affirmation Eudesl
w ' .
A Frovvide the confirmation number when Prior Motice data ha
Confirmation I— . . A been entered uzing the FOb portal or ABI In-Bond application. -
Number I™" Prior Matice Disclaim Mo other data is required. ’
Submitter First Marme: |FIRST Last Mame: [LAST
[required]
Company: |FOREIGM IMPORTER Firmn Type: | Imparter =l
Select.. | Address: |5 FOREIGH WY
| _
City: [ToOKyD )
State/Province: I Phone:  |12345675301234
Zip/Postal Code: I 45568 Fax: 4321098765431
Country: IJP L aman Email: [NONE]
Transmitter o
(roquiod) | Emalt [TOM@IESLTD.COM {
ﬁ[\ltlmpgte .t’-'«mval F'Drt I w __‘*A-".Jlals‘:_ rID(EWQ_DQp u...._._._."'
2011 Page 9
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Ocean Export

e Contents Description

This field now correctly updates immediately after a user updates the “Description” field in the
Cargo section of a Bill of Lading in Ocean Export.

Ocean Import

fAuvpdatecaro
& Update Breakbulk Item / File# 02300003
Description: | TEXTILES FABRICS CON &
Schedule B Mo:
HTS: [ooon.o00o00 |
No. of Pieces: 0.00
Piece Type: I— Q,
Lbs: I—DI}I}I}
Kags: I—DI}I}I}
S ‘ I Drawback tem
Chm: IW
BcDecVae: [ s0 Marks and Numbers

Contents Description

TEXTILES FRBRICS CON

[~
-

Stuffing No: | I This Is A Vehicle

W= =t

Master B/L Desc: | %
Y R ™ _fwm\r* SN SR oo

e Weight on Master/House

The Master B/L now displays a 3-digit decimal place for weight fields to match House B/L
weight fields. This limits the pop-up message that appears if Master weight does not match the
total weight of all attached Houses.

= Ocean Import MASTER

[ Save ) File No: OI111107-061 / MBL: OI111107-061
Divizion  Busz line  File Mumber M aster Bill Mo. I.T. Mumber Entry Mumber Controller
@ Caneel [107 & [0 & [omiorosr Jor11107-081 | Q| feominuser G
@ ) Parties
Eint Account Consignee Shipper Trucker Agent
faccount & [cowsighee & faccount G [TRUCKER & [AGENT Q
@ Sstatus ACCOUNT ID CONSIGNEE FULL NAME ACCOUNT 10 TRUGKER
Transportation
+ Audi Carrier Weszel Wopage Move Type Port of Load ETD Port of Disc
=~ | |c*PRER 0 [vesseL & | | Q | & Jomomo |
g;,é Billing C4RRIER MEARSK NEW JERST
Cargo
ﬁ Other Container Mo, Cnhitr Size/Tupe Total Poe | Total Lbe Total kge CFS / Cargo Loc. Pickup At
[CONT123456 f40 Qf 1ms[| 220460 1.000.000 | oy
@*# Delivery Order AODHRE _
—_ 1| Seals. CFS ETA Date CFS ETéa Time
3 carmo [ Joroomo [ [oon

2011
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PO Direct

e Inventory Labels

The “Inventory Labels” report type has been re-added to the printing options available in PO
Direct and WMS.

Statistics

e Docs Received Date

The field “DOCSRECDDATE” now pulls the correct information from the “Docs Received” date
field located on CHB entries.

e |IT Number in Stats

Existing fields in Stats now allow the IT Number listed on shipments to appear in Stats reports.
Fields labeled “StatsFile:IT NUMBER” and “DO IT NUMBER” now correctly pull the IT Number
information from Import and Delivery Order files.

Warehouse

e Sales Rep Assignment

The system will now allow manual Sales Rep assignment to Warehouse Domestic files if the
Sales Rep commission rules do not apply.

2011 Page 11
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All Modules

e Sales Rep Look-up Screen

New options have been added to the Sales Rep look-up screen. Users now have the ability to
make existing Sales Reps in-active. They also have the option to hide/un-hide these in-active

Sales Reps on the list.

A Browse Salesrep Commission X
Sort
{ I By Salesman L,
~ Filter
Sales Rep: l— 0 A Sales People... x| L
Div: l— Q Sales People... | Show Inactive Salesrep | N
BL:
Q ByID IBy Name I 8
Account: Q i\
. Search:
Consignee: Q Apply Clear |
/ charging At | Division
ent of Charge A Update Sales Person.... [¥]
Cay 10.000% Percent of profit Code: ,m—
cay 50.000% PER SHIPMENT
Name : ICavreISiIvela
=
H|
Nl‘(l 44121 )P] PI]
* Codes with an Asterisk are approved for EDI.
I1|44 412> ))l}ll 4 '—d —wj —\5 '—’d @ ﬁ.l »
—‘_, New Edit Delete Select Print Close _1
- [ i 3 o) ; & &l
| Lot r(.‘) EaTaison (S Apply Rules to Expire -
Insert Edit Delete % from Clients L. Shipments & Salesiep Print Close

Batch Printing Search

A new search filter has been
File Number, MAWB/Master

added to the Batch Printing screen. Users are able to search by
B/L Number and HAWB/House B/L Number depending on which

module the batch printing feature is accessed.
EDI Help

Business Overviews
Activity Reports

°

Billing Reports eSuppart

Customer Activity & Missing Shipper Report
Client Listing

Files not Invoiced
Shipment Register
Missing Shipper
Airline Sales Report

Batch Print Documents

Salesman Reports

File: Humnber |MAWB | HAWE |
Search: |
Twpe | File#t B Haw'B & Conzignes Carrier | P.O. Mumber

M | Floating| 001020

Exporter

[]|House |001023

IRTER

AGENT
SHIFFER

001023 COMSIGMEE

10

IT 1 Direct [001028

[ o102 | SHIPPER [consIGNEE 10 [
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OIES

e Tracing Domestic Files
The Tracing button located in every module now includes an option to search Domestic files
entered in Warehouse Lite.

[@ << AIR FORWARDER 2000+ - TESTDB - DIV 10 >> << ADMIN >> =< D

ZICW Edit Do Quotes AWB's Tracing Reports EDI Help

Bl = 8 85 5

Guoter AWE Invoices Ilacingl}li_lients Contacts

[ Tracking... M= E;
todule Status Sort By Client —
elect
ﬁ Al - ﬁ Al =] ﬁFue Nurber Ed ﬁ m‘
Search For : I
File Mumber | File / Tracking Number | Module

CHE

00016 -

0001658 88500000031 CHE

0001660 8858-0000005-6 CHE

o002 001028 Air Export

o01030 001030 Air Export [ |
o1 1e0-00 00116000 Air Irnport Open
ool 16040 001160401 Air Irnport Open
00116002 00116002 Air Import Open
ool 160-03 00116003 Air Irapart Open
ao1161-00 001161400 Air Imnport Cleared
W44 4] 2w o] 4] |

FM 14

2]
& Wi File [ "’ [ EJ
Select Cloze

e Internal Notes

When entering Internal Notes and Client Notes, users have the option to select which module
the note pertains to. The module “Accounting” has been added to the list of available modules.

A Update Notes and Preferences... E3
Division Lire
al Q
Drezcription
W Prompt zer when uzed
[ Intemal Note Only
PopUpinModules [~ % [~ DE [~ A4E ™ O [~ &l [ 481 [ whee
—Mates
) Time | ; & (%]
Stamp Clauses [ Send Nate to ED| Carrier Save -
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OIES

Accounting

e Invoice Line Items Report

New filter options were added to the “Invoice Line Items Not on an Invoice” report filter screen.
Originally, users were able to run this report for a file creation date range. Users are now able
to run this report by Operations Date (ETA/ETD) as well as file creation date.

UIargE CUUE DasE FIOTT S TUsS

Shipments with Recorded Low Profit ‘
Working Capital :
Cash Forecasting Repaort H

Batch Print Documents L4 ACCO u ntl ng
Unbilled File related AfP Powered by IES ’

A Range for Invoice Details not Invoiced Reporta..

Stait Date : End D ate: Division Business Line
0/00/00 IUJDUJ'DU = Q Q
Customer : Module

¢
{_‘\ |AlModules | j
'
o
4

™ Sot by Contraller I E

I Orly Show Irvaice Lin Items on Shipments ¥ F

¢

{

v
==

e Sales Commission Security

A new default “LEVEL TO VIEW SALES REP COMMISSIONS” was created to control who is
allowed to view the Sales Rep Commission table located in the File menu of the Accounting
module. This capability has also been added to Role Based Security.

Records Processed

e Accounting Manager Login Permissions

The Accounting Manager login is now able to edit wire transfer numbers from the Check
Register screen. Only the login “Accounting Manager” is allowed to change this information.
Prior to this update, the option to change Wire Transfer numbers did not exist.

Wire Trarfer MNo. ‘endor : Check Amount: GAL Acct: G/L Post Date Check Date :

123456783 fvENDOR ﬂ | 9000 | 100000 J { 000,000 [12ms2011 ]
WENDOR CHASE - MaIN

Releaze tethod: Date Releaszed : [ate Deposited ADMIN

B - covoo (| [ooom0000 () T Cleared in Bank Reconciliation

Check Mumber |'vour Reference Mo Papment Dizcount Wendor Feference Mo
0 [11/068/11 $30.00 $0.00[NDON-123456

0 [11/0711 $30.00 $0.00HOM-123456
0 {11/0811 $30.00 $0.00HOM-123456
21 T RN N I T |
YENDOR $90.00 $0.00 Check Status
Inzert | Changel Delete | ’7  Inprogress @ Printed  © Authorized

Comment ; I.&DMIN |5 OK 3 Cancel

2011
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OIES

Air Export

e Air Waybill Count Reminder

Two new system defaults have been added in order to remind users that an Airline’s block of air
waybill numbers is nearly exhausted. By going to File->System Maintenance—>View Defaults
and sorting by the default type Air, the ‘EMAIL WHEN AIR WAYBILL COUNT IS BELOW’ system
default can be set so the reminder is sent when the airline’s block of air waybill numbers meets
this threshold. The email recipient can be set by adding an email address to the system default
‘EMAIL WHEN AWB NUMBER COUNT IS BELOW’. If multiple recipients are necessary, separate
each email address with a comma, with the last email address in the list ending with a comma.

[@] 5¥stem Defaults Maintenance...

Search: [e

<< AIR DEFAULTS >>

I P

MNAR
EMABLE TYPE OF MOVE ON EXPORT A\wWE
FLOATIMG AR HOUSES GET MEW REF
FORCE AIR BILLING
FORCE CHARGEABLE WEIGHT TO KILOS
FOREIGM COMTAINERS
FOREIGM WEIGHTS
FORMAT MawE NUMBER
FUEL/SEC SURCHARGES IN STANDARD RATES

1M 45,100,200,400,200,1000,
1

EULL i Naeiiatemian) SCEEEgbe s g5 0.
ﬁSystem Defaults Maintenance... M= §
Search | << AIR DEFAULTS >> o
| Type | value |
SYSTEM {
i1 = 1
OCEAMN MaASTER &\wEB BODY SHOWS INBOND MUMBERS ’
IMPORT MASTER AWwE BODY SHOWS PO MUMEBERS &
WAREHOUSE MASTER COMPARES GROSS AND DIM WT OMLY 1
ACCTG MawE #ALLOCATION PROCESSING
SED MawE COMRMISSION CHARGE CODE AlR COMMIS
EDI M&wE FREIGHT CHARGE CODE AIRFREIGHT
REMOTE Ma'WwEB FUEL SURCHARGE CHARGE CODE FUEL
AB| MawE FUEL SURCHARGE RATE
ABIIMTERFACE MawE SCREEMING SURCHARGE CHARGE CODE
TR&MSFER MawE SCREEMING SURCHARGE RATE
FRINT MawE SECURITY SURCHARGE CHARGE CODE SECURITY e
REPORTS MaWwE SECURITY SURCHARGE RATE '
REFEREMCE MawE wiaR SURCHARGE CHARGE CODE —?
SECURITY MawE Wik SURCHARGE RATE L
STAMDARD MIMIMUR AR EXPORT MARKUP PCT. 10%
HIDDEM FIELDS MIMIBLR &R IMPORT MARKUP PCT. 10% '
CUSTOM FIELDS j M WEIGHT UMIT OM US COMSOL TOTALS IMN Kags :
NEW AIR QUOTE )
_x POP3 Email Config. | MEW &WwWE PRINT OFTIONS -
MEW DOMESTIC &lR SHIPMENT TFE /
it MEW DOMESTIC AlR USES PICK-UP REQUEST
—— HoTl JMQW‘\’.\‘ _MJHMM'-&"W“M

2011

Page 6

All information contained herein is confidential. IES: The Software Solution for the Future of Freight.



OIES

CHB

e Audit Log on Notes

A “Notes” log option has been added to the “More” button on the Entry form to keep track of
information added, edited or deleted.

Entry Humber  Broker Ref. Entry Type Gross Weight Charges Motes are um. Date
[%E700321815 [10%501053 | o1 O | 100KG | #1001 added/edited here 7
[~ Live I Manual Entry e e v D HERR Linl&\_——’_‘ M_I

General |L|anifest | Invoices | 7501 |§4Bl | Payment | Selectivity I§lalus | Reconciliati Iﬂoles

DivisionW Business Line:ﬁ Opened: IW
Parties Imparter Of Record: # Cust. Ref.: I—

Ultimate Consignee:

i i g State Of Destination: [k G
Account: i Q] Ewxam Fort: I (o]

Transportation Mode: I 40 Q Air, Mlon-container “Yopage/Flight: {123 Yessel Cude.l
Carrier: |ED L, CONTINENTAL AIRLINES, INC. “esse| Name: |
Arrival Port of Entry: |45m L4, MEM YORKINEWARK AREA Estimated Arival Date: [11/21/11 &=
Part of Unlading: |4BDT L4, MEM YORKINEWARK AREA Irnpart D ate: 11/21411 =]
Location of Goads: |E823 L, CONTIMENTAL AFLINES General Order Number:
Bond Type:[ 8 - Continuous Bond > Swety {741 w|  Account | Amount:l
Missing . I— I—
Documents E “ 3 “
‘Warehouse Enty Mumber, I Part: I
Begitning Huatitity: I 0 ithdraysal Guartity: IU Remaining Buartity: [0
1
(2| 7 | &|lala|oe
Status Adjustments LDiocs Submit Frint Save Lancel
AUdIt ‘Og Of notes is 7501 Format: Grouped by Inwoice Form “Jersion &

availble here

Time Skamp”

o Flagged Recon Entry List

A print button was added to the Flagged Entry browse window. The report prints a listing of
entries flagged for reconciliation. Users have the ability to filter results prior to printing.

@Recunciliatinn Importer: WS S8Es 8 ol pELe i

Overall Status | Reconciliation History  Flagged Entries

Reconciliation Pending by Broker Reference | Frint | |

ﬁearch:l— Mew... | Wiew... |

Broker Ref | Blanket | MAFTA [ MAFTA Due | Yalue | Class| 9802 Other Due
108500445 v 2/28/2012| Hold, Mot Ready [Imported)
105500502 3A8/2012 | Hold, Mot Ready [Imported) )
105500523 2972012 Hold, Mot Ready (Imported)

105500526 40772012 Hold, Mot Ready [Imported) b
474,202 Hold, M eady [Impoarted] f
) o ed)

Entry Mumber
#ET7-0031549-4
XEF-0031608-28
HEF-0031629-4
HET-003632-8
HEF-00RE33-E

CRZ

108500527

2 vy
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OIES

e Harmonized Tariff Enhancements

CHB has been updated to display the Participating Government Agency (PGA) code. Once CBP
has added PGA codes to HTS Updates, they will display in the IES CHB module.

WAL dday

e Query Manifest Feature

General T aniff Number: |442D.‘ID.DDDD Categary Number: I
Description: S TATUETTES, OTHER DRMAMENT| [ additional Tariff may be requin
Subject To: [T Countervaiing I Antidumping [~ Quota '
Parmit: |
E ffective: | 2/m09
Quantty Urits: [ | |
Duty Column 1 Farmula: |3_2Z of Yalue
Caleulation ¢\ i 2 Formuls. [T3.357539% of Value
Special Special Programs: |A E J P AUEBHCACLILJD MA M= OM PE S5G
[Fepems G5F Excluded Countries: |
Agoncies | [NoOGADataforthis Tarlt |f HTS has PGA code, It displays here
Edits Contry: |Hone
Yalue: |Hone
Quantity: [Mone
Entry Date: |Hone

When using the “Query Manifest” feature in CHB, the system will now display the IT Number
after querying the MBL. If more than one IT Number exists on the MBL, CBP sends the last one.

[@ Bill of Lading =
Bill of Lading: | |[E]RE=E IR IT Number: ['VBROO1 00166 )
House Bill: | Received: |12.-J28.-J2|:I11 224 Pid
Carrier: [EGLY Wesset  [LOUDS ISLAND '
Woyage/Trip: [010W Buantity:  [1.156 JCTH t
Arrival: I'ID:'S'I 2011 Tupe: IMaster
Il ode; IDcean ISF Filed:  |*%es
Lacation: Query Bil

Fiefresh
Dizpogitions: | Date Time Guantity | Code | Marrative ,
10/20/2017 11115 4AM 0 Z£ |SECFIL OMFILE
. 104242017 | 341 AM 0 54 |CARAMEMND DEL
Vrmtn Tl s D YD s

2011
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OIES

Denied Party Screening

e Version 2 Release

In the latest IES Release, Denied Party Version 2 is now available. Please contact IES Support if
you currently use the Denied Party Screening System to have this activated. To have this
activated, you must have IES Build #20111212.0901 installed or later. You can check this in the
IES Export modules within the Help menu, under the “About” section.

In DPS Version 2 there is no change to the process of checking your shipments or parties against
the DPS system.

EDI

e EDI Detail Report

A Detail Report has been added to the EDI Message Center screen to show more details than
the Summary Report that already existed.

[®) Browse EDI Messages... =l E3
Search PresstoSearch | Type [ =] Statws[watng =] Diestion | © Sent & Received | SearchYiew
g o 3 Div

pe
DO RO%ANCO

System Message...

B -
lel Run Detail Report Instead Of Summary Feport
b 4

K| I
* = Amendment
Process Al | Caneel Al | Browse Matches IBS
@
Process Message | Cancel Message ‘r& &l
.
PO Direct

e Access of Authorize to Pack

A new default “Require Exclusive Access for Authorize to Pack” was created to limit multiple
access to Authorize to Pack functions at the same time. Only one of these activities may occur
at the same time:

e Create or edit an Authorize to Pack.
e Scan items onto Authorize to Pack Hand Held.

e Add an Authorize to Pack item to a Load Plan.

2011 Page 9
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OIES

e Printing Labels

There is a new option to print individual “Row/Rack/Bin” labels, or a batch vs. the entire
location/batch only.

TEST DB - DIV 10 >> << ADMIN >> << DEV >>
Flle Operations  Shipments  Inventory Reports EDI Help Edit
CM Codes
Consignee Set-Up
Country Specific Clauses
Destination (Regions)
Events
Incoterms
Packaging
Parts
Part Templates
Vendor 4

Warehouse Packaging

Workgmups

A Edit Warehouse Locations

Warehouse :
10 o
Section
IA j I Mew Section | Delete Section |
Rows : Racks : Bins : (TR
ROW

Print %]

@ Choogze Print Option

Batch | Single Row Single Bin |
Mew | Delete | Mew | Delete | Mew | Delete |

= Buint | 511 Cloze |
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OIES

Statistics

e New Title Header Default

A new system default “ENABLE COMPANY BRANDING IN STATISTIC REPORTS” has been created
to control the title header of Statistics reports. When enabled, stats reports will include
company’s information as indicated below.

) i 5] C D E F G

1 [TESTDB-DIV 1D

2 (1200 STREET ADDRESS

3 |DIV 10 CITY,NJ, 07154-5412

4 Phone:PH: 905-677-0444, Fax:FAX: 905-677-8444

5 website/email:

6 |Shipment Tots

7 FILE NO REFERENCE NO CUSTOMER NAME REVENL EXPENSPROFI ETA DAT ACTUAL
8 "D001660 0001660 ACCOUNT ID #HHER 50.00 =

9 001023 001023 ACCOUNT ID #HE 50.00 #HEER

10 D01028 001028 ACCOUNT ID 50.00 30.00 3%0.00

11 001160-01 001160-01 ACCOUNT ID 50.00  50.00 30.00 #He
12 1001160-02 001160-02 ACCOUNT ID 50.00 50.00 30.00 #HEHHHH

e New Client Statistics Report fields

New fields have been added to Client Stats Reporting. The fields listed below are linked to each
client from the ‘View Salesman Commissions” menu under File->Tables Maintenance in the IES
Accounting module.

Define the Spreadsheet Column Layout 3\‘
5 thoze figlds you wish to show. The figlds will be placed fran left ta right in vour zpreadzheet. y
b

3 Add -» | MAME
SALESHAN
Add Report Field | SALESHMAN 1D
SALESMAN ACCOUNT ID
<- Remove | SALESHAM COMSIGHEE ID
SALESHAM SHIFPER 1D

Add Al - | SALESMAM DISCHARGE PORT

SALESKMAMN LOAD PORT
<- Remave Al | SALESHAM EFFECTIVE DATE
SALESHAN EXPIRATION DATE
SALESHMAMN CALC BASIS
SALESHMAMN CALC AMOUNT

his is the salesman field
rom the Accounting
nformation

Show these fields in this order:

s

These fields relate directly to
the Salesman Comission Table.
f a client has more than one
Ealesman associated to them it
will seperate each value with a
.

[« |
Format Field | * | I 7ot _
Header | & | [~ Sub:Tiot
Field Information
LILI Type: String
Format: AS 15

2011
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OIES

IES Release 1112 New System Defaults

In the new IES update version 1112, the below System Defaults have been added. The majority of these
defaults are categorized as “SECURITY”, which means that they control a specific IES function from being
performed based on your users Security Level or Role Based Security setup. Please take note of these
defaults and contact IES Technical Support if you are interested in any further details as they relate to these
defaults.

Default Default
System Default Result System Default Name etau etau
Category Value

Use board feet instead of cubic feet prompts PROMPT FOR BOARD FEET

before conversion CONVERSION SYSTEM On/Off

Enables Diagnostic Messages ENABLE DIAGNOSTIC MESSAGES ACCTG On/Off
CLIENT STATEMENT ALWAYS

CLIENT STATEMENT ALWAYS FILTERS FILTERS ACCTG On/Off

Enables Filtering of items using the Users ENABLE USER VIEW FILTERING ON

Division List on Biling and F9 Reports BILLING AND F9 REPORT ACCTG On/Off

G/L Account to be used when Auto-Settling INTER-DIVISION BILLING AUTO-

Inter-Division Invoices SETTLEMENT ACCOUNT ACCTG G/L Acct No.

Enables Automatic Settlement of Inter-Division | ENABLE INTER-DIVISION AUTO-

Invoice Items SETTLEMENT ACCTG On/Off

AWB Count

EMAIL WHEN AWB NUMBER Minimum

EMAIL WHEN AWB NUMBER COUNT IS BELOW | COUNT IS BELOW AIR No.

Email addresses separate by commas, will

trigger notification when the # in the default Email of

EMAIL WHEN AWB NUMBER COUNT IS BELOW note

is reached LOW AWB COUNT EMAIL AIR recipient(s)

Disable ITN copy option on new AWB DISABLE COPY ITN ON NEW AWB AIR On/Off

With the default set to true (checked), the
Issuing Carrier's Agent Name and City will use IATA AWB SET USE DIVISION AS

the Division Address assigned to the shipment. | AGENT AIR On/Off
Enter in the TSA Security Program text to be IATA AWB SET TSA SECURITY AWSB printed
printed on the IATA AWBs. PROGRAM TEXT AIR text

With the default set to true (checked), the AES
number will be in the body of the AWB and
does not need to be printed at the bottom of IATA AWB SET AES NUMBER IS IN

Marks and Quantity of Goods. THE BODY AIR On/Off
Enable this option to hide the Direct Payment OE DOES NOT SHOW DIRECT
Method selection on the Bill Of Lading form. PAYMENT METHOD OCEAN On/Off

Determine where Marks and Numbers appear
on the b/l body when this field is enabled on

the Content screen. CONTENT MARKS EXPLODE TO OCEAN BODY
Level or Capability to Enter PrePayment Checks | LEVEL TO ENTER PREPAYMENT Level up to
in Accounting CHECKS SECURITY 9999
Level up to
Level to Edit A Deleted A/R LEVEL TO EDIT DELETED A/R SECURITY 9999
2011 Page 2
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OIES

Level or Capability to Edit External ID Field on LEVEL TO EDIT CLIENT EXTERNAL Level up to
Client F10 Accounting Window ID FIELD SECURITY 9999
Level to access the Calendar Button of an In LEVEL TO CHANGE AN IN Level up to
Progress A/R Invoice. PROGRESS A/R DATE SECURITY 9999
Level or Capability to View Journal Entries in LEVEL TO VIEW JOURNAL ENTRIES Level up to
Cash Receipts Browse IN CASH RECEIPTS BROWSE SECURITY 9999

LEVEL TO SELECT NON-BANK GL
Level or Capability to Select a Non-Bank G/L ACCOUNTS WHEN ENTERING Level up to
Account when entering Checks CHECKS SECURITY 9999
Level to access the Edit Cargo Button in the LEVEL TO USE EDIT CARGO Level up to
Warehouse Receipt. BUTTON IN W/R SECURITY 9999
Level to access the Delete Cargo Button in the LEVEL TO USE DELETE CARGO Level up to
Warehouse Receipt. BUTTON IN W/R SECURITY 9999
Level to access the Single SKU Button in the LEVEL TO ACCESS SINGLE SKU Level up to
Warehouse Receipt. BUTTON IN W/R SECURITY 9999
Level to access the Multi SKU Button in the LEVEL TO ACCESS MULTI SKU Level up to
Warehouse Receipt. BUTTON IN W/R SECURITY 9999
Level to access Review Prior Cash Batches LEVEL TO REVIEW PRIOR CASH Level up to
menu in the accounting. BATCHES SECURITY 9999
Level to access Reverse a Cash Batch Sequence | LEVEL TO REVERSE A CASH BATCH Level up to
menu in the accounting. SEQUENCE SECURITY 9999
Level to access Cash Receipts Journal menu in LEVEL TO ACCESS CASH RECEIPTS Level up to
the accounting. JOURNAL SECURITY 9999
Level to change (or leave blank) the division
field when setting up a client specific charge LEVEL TO CHANGE CLIENT CHARGE Level up to
code. CODE DIV SECURITY 9999
Level or User Role to Override A/R Maximum LEVEL TO OVERRIDE AR Level up to
Write-Off Amount MAXIMUM WRITEOFF AMOUNT SECURITY 9999

LEVEL TO OVERRIDE AR
Level or User Role to Override A/R Maximum MAXIMUM ADJUSTMENT Level up to
Adjustment Amount AMOUNT SECURITY 9999
Level or User Role to Override A/P Maximum LEVEL TO OVERRIDE AP Level up to
Discount Amount MAXIMUM DISCOUNT AMOUNT SECURITY 9999

LEVEL TO OVERRIDE AP
Level or User Role to Override A/R Maximum MAXIMUM ADJUSTMENT Level up to
Adjustment Amount AMOUNT SECURITY 9999
Level to edit a purchase order line item that LEVEL TO EDIT EDI CREATED PO Level up to
was created via EDI. ITEM SECURITY 9999
Level to delete a purchase order line item that LEVEL TO DELETE EDI CREATED PO Level up to
was created via EDI. ITEM SECURITY 9999
Level to add a new line item when the LEVEL TO ADD ITEM TO AN EDI Level up to
purchase order was created via EDI. CREATED PO SECURITY 9999

LEVEL TO VIEW SALESREP Level up to
LEVEL TO VIEW SALESREP COMMISSIONS COMMISSIONS SECURITY 9999

LEVEL TO MODIFY DASHBOARD Level up to
Allow dashboard display formats to be edited DISPLAY FORMATS SECURITY 9999
Allow the main dashboard options to be LEVEL TO CONFIGURE THE Level up to
changed DASHBOARD SECURITY 9999
LEVEL TO ACCESS PODIRECT UNLOAD SESSION LEVEL TO ACCESS PODIRECT Level up to
SCAN UNLOAD SESSION SCAN SECURITY 9999
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LEVEL TO ACCESS PODIRECT UNLOAD SESSION LEVEL TO ACCESS PODIRECT Level up to
MANAGER UNLOAD SESSION MANAGER SECURITY 9999
LEVEL TO ACCESS PODIRECT Level up to
LEVEL TO ACCESS PODIRECT RETURNS RETURNS SECURITY 9999
LEVEL TO ACCESS PODIRECT
LEVEL TO ACCESS PODIRECT REPORTS REPORTS WAREHOUSE SHIPPER Level up to
WAREHOUSE SHIPPER KPI KPI1 SECURITY 9999
LEVEL TO ACCESS PODIRECT REPORTS LEVEL TO ACCESS PODIRECT Level up to
WAREHOUSE KPI REPORTS WAREHOUSE KPI SECURITY 9999
LEVEL TO ACCESS PODIRECT REPORTS LEVEL TO ACCESS PODIRECT Level up to
SHIPMENT REPORTS SHIPMENT SECURITY 9999
LEVEL TO ACCESS PODIRECT REPORTS LEVEL TO ACCESS PODIRECT Level up to
PRERECEIPT-ONHAND REPORTS PRERECEIPT-ONHAND SECURITY 9999
LEVEL TO ACCESS PODIRECT REPORTS PO LEVEL TO ACCESS PODIRECT Level up to
AUDIT REPORTS PO AUDIT SECURITY 9999
LEVEL TO ACCESS PODIRECT Level up to
LEVEL TO ACCESS PODIRECT REPORTS PARTS REPORTS PARTS SECURITY 9999
LEVEL TO ACCESS PODIRECT Level up to
LEVEL TO ACCESS PODIRECT REPORTS ONHAND = REPORTS ONHAND SECURITY 9999
LEVEL TO ACCESS PODIRECT Level up to
LEVEL TO ACCESS PODIRECT REPORTS AGING REPORTS AGING SECURITY 9999
LEVEL TO ACCESS PODIRECT Level up to
LEVEL TO ACCESS PODIRECT REPORTS ACTIVITY = REPORTS ACTIVITY SECURITY 9999
LEVEL TO ACCESS PODIRECT REPORTS A2P LEVEL TO ACCESS PODIRECT Level up to
ACTIVITY REPORTS A2P ACTIVITY SECURITY 9999
LEVEL TO ACCESS PODIRECT PRE- Level up to
LEVEL TO ACCESS PODIRECT PRE-ADVICE ADVICE SECURITY 9999
LEVEL TO ACCESS PODIRECT JOB Level up to
LEVEL TO ACCESS PODIRECT JOB LOG LOG SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY SMALL | LEVEL TO ACCESS PODIRECT Level up to
PARCEL INVENTORY SMALL PARCEL SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY LEVEL TO ACCESS PODIRECT Level up to
SEARCH WR INVENTORY SEARCH WR SECURITY 9999
LEVEL TO ACCESS PODIRECT
LEVEL TO ACCESS PODIRECT INVENTORY INVENTORY SEARCH SERIAL Level up to
SEARCH SERIAL NUMBER NUMBER SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY LEVEL TO ACCESS PODIRECT Level up to
PALLET AUDIT INVENTORY PALLET AUDIT SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY ON LEVEL TO ACCESS PODIRECT Level up to
HAND INVENTORY ON HAND SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY LEVEL TO ACCESS PODIRECT Level up to
LOOKUP INVENTORY LOOKUP SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY HOLD LEVEL TO ACCESS PODIRECT Level up to
RELEASE INVENTORY HOLD RELEASE SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY LEVEL TO ACCESS PODIRECT Level up to
ASSEMBLY INVENTORY ASSEMBLY SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY LEVEL TO ACCESS PODIRECT Level up to
ADJUST INVENTORY ADJUST SECURITY 9999
LEVEL TO ACCESS PODIRECT INVENTORY LEVEL TO ACCESS PODIRECT Level up to
SEARCH INVENTORY SEARCH SECURITY 9999
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LEVEL TO ACCESS PODIRECT INVENTORY LEVEL TO ACCESS PODIRECT Level up to

OVERPACK INVENTORY OVERPACK SECURITY 9999

LEVEL TO ACCESS PODIRECT INVENTORY AUDIT | LEVEL TO ACCESS PODIRECT Level up to

RUN INVENTORY AUDIT RUN SECURITY 9999

LEVEL TO ACCESS PODIRECT INBOUND LEVEL TO ACCESS PODIRECT Level up to

SCHEDULER INBOUND SCHEDULER SECURITY 9999

LEVEL TO ACCESS PODIRECT FLOW LEVEL TO ACCESS PODIRECT FLOW Level up to

DASHBOARD DASHBOARD SECURITY 9999

LEVEL TO ACCESS PODIRECT EVENT LEVEL TO ACCESS PODIRECT Level up to

DASHBOARD EVENT DASHBOARD SECURITY 9999

Level or User Role to Allow Edit of Collections LEVEL TO EDIT COLLECTIONS Level up to

Group Settings GROUP SECURITY 9999

Enable/Disable Company Branding in Statistic ENABLE COMPANY BRANDING IN

reports STATISTIC REPORTS SYSTEM On/Off
CLEAR COMMENTS ON UN-

Clear up event notes when un-complete event COMPLETE EVENT SYSTEM On/Off
CHECK FOR DUPLICTATE MASTER

Check if master bill number was already used. BILL NUMBER SYSTEM On/Off
CHECK FOR DUPLICTATE BOOKING

Check if booking number was already used. NUMBER SYSTEM On/Off

TruVis will be used to store the Power of

Attorney documents that will be checked ENHANCED TRUVIS AES

before allowing AES to be submitted. DOCUMENTATION SYSTEM On/Off
CLIENT PRINTABLE ADDRESS IS

A client's printable address may not be blank. REQUIRED SYSTEM On/Off

Populate client charges division from the AUTO-POPULATE CLIENT CHARGES

current user's division. DIVISION FROM USER SYSTEM On/Off

Prevents a new release from overwriting

Package Types. ISO PACKAGE TYPES LOCKED SYSTEM On/Off

Enable/Disable user module permission for ENABLE USER MODULE

statistic PERMISSION FOR STATISTIC SYSTEM On/Off

Allow only one user at a time to work an REQUIRE EXCLUSIVE ACCESS FOR

authorize to pack. AUTHORIZE TO PACK WAREHOUSE On/Off

When the default LOAD PLAN CREATES ONE

CONTENT RECORD is enabled, use this default

to enter in the module numbers it applies to.

Example 02 = OE, 03 = AE. Leave blank to apply | LOAD PLAN CREATES ONE

to all modules. CONTENT MODULES WAREHOUSE On/Off
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